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Student Resource 7.1
Assignment: 
Creating a Report with Microsoft Word
A good way to learn new Microsoft Word skills is to use Word to create a professional document. For this assignment, you will create a report that includes the project planning pages for your dream personal technology system. 
Your report will include a title page, one page for each of your project planning resources, and a project planning summary table that summarizes the information for each component of your dream technology system. You have already completed project planning pages for your hardware and peripherals, so these will be the first pages you incorporate into your report. As you work through the other components for your dream system in future lessons, you will add those pages to your report. 
To create this report, follow the tutorial in Student Resource 7.2 step by step. Your completed report should look similar to the example report in this resource. Before you begin work on your report, read the assessment criteria and ask your teacher for more information if you have questions about any of them.
Make sure your report meets or exceeds the following assessment criteria:
The title page is formatted using a template. The date is formatted correctly. The page includes a relevant picture, and the picture has some type of style formatting (such as a border). All elements fit nicely on one page.
The two project planning pages contain pertinent information about hardware and peripherals.
The project planning pages are formatted correctly: 
The header is right-aligned and shows student names.
The title and subtitle are formatted correctly.
The major headings use a heading style. All major headings use the same style.
Bulleted items use a bullet style. All bulleted items use the same style.
All elements fit nicely on each project planning page.
The project planning summary table has a header, title, and subtitle formatted correctly. The summary table itself is formatted with two columns. The heading rows are bold. The information in the table is useful.

Example: Planning a Dream Technology System Report
Your four report pages should look something like this:
[image: ]
Student Resource 7.2
Tutorial: Creating a Report with Microsoft Word
Directions: Follow the instructions in this tutorial to use Microsoft Word to create your report containing the project planning resources for your culminating project. 
Step 1: Creating a New Document with a Template
Microsoft Word comes with many templates designed to make your documents look professional. Using an existing template that is designed specifically for a report will save you time and make it easy to create a report for your culminating project. For your “Planning a Dream Personal Technology System” report, use Word’s Median Report template. Here’s how to get started.
Create a new document in Microsoft Word and choose the Median Report template, like so: Click the Microsoft Office button and select New. In the search templates box at the top of the Window, type Business Report Median Theme. Double-click the template that displays to open your document with this template.
Save your new document to a safe place on your hard drive, on a flash drive, or on OneDrive, like so: Click the Microsoft Office button and select Save As. Give your document a meaningful name and save it in the folder where your teacher has instructed you to save your work.
Step 2: Creating Your Title Page
On the title page of your new document, click in the [Type the Document Title] section, and type Planning a Dream Personal Technology System. 
If the title seems too large, you may want to adjust the font size. You can do this using the mini toolbar. Use your cursor and mouse to select the text in the title, and then right-click to display the mini toolbar. In the font size box, try different numbers until the text looks the way you want it to.
The template makes it easy to put a date on your report. In the “Pick the date” box at the bottom left, select today’s date. (You can revise this date later when you are ready to turn in your report.)
For your report, you don’t need a subtitle, but you can use the “Type the document subtitle” box to insert the names of your group members. 
You don’t need an abstract for your report, so you can delete the row of the table on the title page that has a place for an abstract. Click anywhere in the abstract, and then click the Layout tab on the ribbon. In the Rows & Columns group, click Delete > Delete Rows.
You’ll need to replace the picture on the title page of your report with a picture of your dream technology system. You may not really know what it will look like yet, but you can find a picture on the Internet that shows elements of the kind of system you think you will choose.
Copy the picture that you chose to the folder where your teacher has instructed you to save your work, and give the picture a meaningful file name.  
To insert the picture on the title page of your report, click the picture that is currently on the title page to select it. Next, click the Insert tab on the ribbon, and in the Illustrations group, click Picture. In the dialog box, locate and select your picture file, and then click Insert.
To resize the image so that it fits nicely in the box, click the image to select it, and then drag its sizing handles to make it larger or smaller. To maintain the height/width ratio, be sure to drag it using a corner sizing handle. You can also ensure that the height/width ratio remains consistent by right-clicking the picture and selecting Size. Under the Scale section, make sure the “Lock aspect ratio” box is checked, and then increase or reduce the percentage in either the height or width box, and that will resize your picture.
Just as you can format text with styles, so can you format pictures with styles. To set off your dream system picture, apply a picture style to it. Click your picture to select it, and then click the Format tab on the ribbon. In the Picture Styles group, play around with the different styles until you find something that you like. Try out the different Picture Shape, Picture Border, and Picture Effects options in the drop-down menus at the right of the Picture Styles group.
Now look at your page as a whole and make any changes you need to, to make it attractive. Make sure that everything fits nicely on one page. When you are happy with the look of your title page, save your document. 
Step 3: Creating Your Report Pages
The next step is to create the pages of your report—one page for each page of your project planner. In previous lessons, you filled in Project Planner Page 1 (hardware) and Project Planner Page 2 (peripherals) for your culminating project. You can copy the information on those pages into your report and then format the information using the report styles to make your report pages look professional.
Note that the title of your report is already at the top of page 2. This box automatically contains the title text you typed on page 1. The title will probably look better if it is all on one line, so you may want to select it and change the font size, using the mini toolbar. 
To keep track of the project planning pages in your report, you can use a subtitle on each page. In the Subtitle box, type Project Planner Page 1. For each page of your report, use the project planner page as the subtitle.
Rather than listing the names of students in your group in the text box on each page of your report, let’s put them in the header. That way they will be on each page, but you won’t have to reenter this information on each page. People will be able to spot the names and know whose report they are looking at.
At the top right of the page, double-click in the header text “Planning a Dream Personal Technology System,” and remove the text. Then type in names of your group members. This new header text should display on all pages of your report except page 1. Hint: Make sure you completely remove the header text that references the title on your title page. If the header is still linked to the title, the title will change too!
Copy page 1 of your project planner (the page about hardware) into your report. If you wrote your project planning page on paper, just type the information into the text box, and you will format it in the next step. If you have the project planning page as a Word document, you can open that document, copy the sections you filled in, and paste it into your report as follows: 
Open your Project Planner Page 1 document. Using your cursor and mouse, select the text in your project planner starting with “What this computer system will be used for” all the way to the end of your document. To copy the selected text, use the Ctrl+C shortcut.
Now go back to the document where you are creating your report. Place your cursor in the text box (below the title and subtitle) on page 2 of your report, and use the Ctrl+V shortcut to paste the text that you copied. (The text you copied should replace the template text.) After you paste your text, click the arrow on the Paste Options icon that displays, and select Match Destination Styles. It’s important that you select Match Destination Styles so that you don’t bring styles that you don’t want into your document. Later you can fix up the formatting and make it look like you want.
It will be easier to work on formatting your page if you display formatting marks. This helps you see where each paragraph begins and ends, any tab stops, and any page breaks. To display formatting marks, click the Home tab on the ribbon, and then in the Paragraph group, click the ¶ icon. 
The report template has a set of styles that will give your report a professional look and feel. The best way to work with these styles is to display the Styles box. Because you will be using the Styles box often, it is a good candidate to put on the Quick Access toolbar. The Quick Access toolbar is a great place to store all the buttons that you use often so that you don’t have to go looking for them on the different tabs and groups. Do you see the Quick Access toolbar above the ribbon? This is what the default Quick Access toolbar looks like:

[image: Quick Access Toolbar in upper-left corner]

To place the Styles box on the Quick Access toolbar, do the following: From the Home tab, right-click the arrow at the very bottom right of the Styles group, and select “Add to Quick Access toolbar.” You should see the Styles icon in your Quick Access toolbar. Try adding another feature that you use often to the Quick Access toolbar using the same method. 
The next task is to assign styles to the text in your report. Click the Styles icon in the Quick Access toolbar to display the Styles box. Then select sections of text and apply a style to them to make your report look professional. Here are some suggestions:
[bookmark: _GoBack]Use the Heading 1 style for the headings and questions, such as “Hardware we plan to puchase.”
Use the Normal style for your responses. 
For the list under “What we need to consider about the following,” use the List Bullet 3 style.
When you are happy with the styles you are using, make sure all of your information fits on one page. If it doesn’t, you can adjust the font size from the Font group on the Home tab, or you can adjust the line spacing and paragraph spacing from the Paragraph group on the Home tab. 
At the end of your page, make sure there is a page break so that the next page of your project planner will start on a new page. If you are displaying formatting marks, you can see if there is a page break. If there is not, put your cursor at the bottom of the page and click the Insert tab on the ribbon, then in the Pages group, click Page Break.
The next page in your report will be your project planner page about peripherals (Project Planner Page 2). Start the page with a title and a subtitle, just like the page you just finished, and then open your Project Planner Page 2 document and copy the text about your peripherals into your report. Format the text in your report the same way you formatted the previous page. Remember to add a page break at the end.
Step 4: Creating Your Project Planning Summary Table
The last page in your report will be a table that summarizes the information in your project planner. You should create that page now and fill in more information as you add each page to your report. This means you will end up adding a line to this table for each project planner page you complete.
On the next page of your report, put a title and a subtitle. For the subtitle on this page, type Summary. 
Create a table with 2 columns and 10 rows as follows:
From the Insert tab on the ribbon, click the Table arrow in the Tables group, and select Insert Table.
In the dialog box, specify a table with 2 columns and 10 rows and click OK. 
In the header row of the table, left column, type Type of Component. In the right column, type Our Choices.
Fill in the table according to the information on your planning pages. (For example, in the first row, type Hardware in the left column, and type your chosen hardware components in the right column.)
Adjust the fonts and font sizes to make your table look professional. Use bold typeface (select the text and press Ctrl+B) for the heading rows.
Finishing Touches
Before you hand in your report, you need to check grammar and spelling and then update the document properties to list yourself as the author of the document. Then you are ready to print your report and submit it to your teacher for assessment.
To check your report’s spelling and grammar, click the Review tab on the ribbon. In the Proofing group, click Spelling & Grammar. The spelling and grammar checker will display each potential problem it finds. You can click the Ignore button to leave the selection as is, or you can select a suggested alternative and click Change to modify the text.
Update the document properties to list you as the author and “Planning a Dream Personal Technology System” as the subject: Click the Microsoft Office button and select Prepare. Next, select Properties on the submenu. In the Properties box that displays below the ribbon, enter your name as the author, and enter Planning a Dream Personal Technology System as the title.
When each page of your document looks exactly the way you want it, you’re ready to print your report. 
Save your file before printing it. You will need to have access to this report so that you can continue to update it for your culminating project.
From the Microsoft Office button, select Print. In the dialog box, select the printer that your teacher instructs you to use, and click OK. 

Student Resource 7.3
Reading: Introduction to Spreadsheets
What Is a Spreadsheet?
Imagine working at a company and being in charge of entering volumes of data—facts and figures—for multiple departments, product lines, or locations. You’d need to organize all the information into one place. Accountants and bookkeepers have always used spreadsheets with columns and rows, originally on paper, to record and organize financial information. Within a spreadsheet, categories typically run across the top in columns, while types of payments or expenses run down the left side, in rows. A figure or value is placed where a row and a column converge.
When people began to use computers to organize accounting and payroll data and to generate reports, electronic spreadsheets were developed to run within software applications. Using formulas, these spreadsheets help people quickly and accurately calculate numbers and other information. As we will see, spreadsheet programs are smart enough to adapt a formula when it is copied from one location to another, so that the computation made impacts different data. 
[bookmark: Autoplan.2FAutotab][bookmark: Interactive_spreadsheets][bookmark: Early_implementations][bookmark: Batch_spreadsheets][bookmark: VisiCalc]One of the first spreadsheet software programs was VisiCalc in the 1970s. Other programs developed and added presentation abilities. Similar to what happened with word processing, spreadsheet software became easier for people to use. 
How Are Spreadsheets Organized?
All spreadsheets are basically grids of cells. Cells are the spaces where you can input different values. The columns of the grid are labeled across the top of the spreadsheet using letters, from A to Z, then AA to AZ, and so on. The rows are labeled along the left side using numbers. The most basic spreadsheet programs allow you to have at least 256 rows and columns, while more powerful programs increase this limit to the thousands.
Each cell in a spreadsheet has a cell address, which can be used to identify it. The cell address consists of its column and row labels—so, the cell address for the cell in the D column and seventh row would be D7. If you click in a cell, its address will be displayed in the cell address box, which is usually near the upper-left corner of the window.
You don’t have to select cells one at a time; you can also select a range of cells. You can define the range you want with the first and last cells of the range separated by a colon. Typing B2:B8 in the cell address box will select the cells in the B column from the second row to the eighth row. Typing F12:K20 will select all the cells in columns F to K from rows 12 to 20. You can also select all the cells in a column by clicking the column label at the top of the spreadsheet and select all the cells in a row by clicking the row label.
With larger spreadsheets that have more than a few dozen rows or columns, not all the data will be able to fit on the screen. In these cases, the spreadsheet program is like a window that can be moved to look at the different parts of the spreadsheet. In addition, spreadsheets have multiple tabs or pages.  
Entering Data
Near the top of the screen, there should be a white box that stretches across the screen. This is the data entry box, where you can input data for the different cells. You can also type information directly in the cells on the spreadsheet. However, if your data is more than a few characters, you may find that the cells are too small to display everything you are trying to type. This is especially true for entering formulas, because they are longer and you’ll want to see the entire formula you are entering to be sure you haven’t made any mistakes.
A good method is to use both the grid and the data entry box. You can select the correct cell and begin entering data, making sure to look at the complete entry in the data entry box to check for correctness. 
Checking the data entry box is also important for checking the contents of the cell, as opposed to the value of the cell. For example, if you have a cell with “=SUM(C3:C6)” (which in some spreadsheet programs will add the values of the cells in column C, rows 3 to 6), then on the spreadsheet it will display a number—the sum of the values in that range. But the “=SUM(C3:C6)” formula will remain in the data entry box to remind you where the value that displays came from.
In addition to numbers, spreadsheet cells can contain text, dates, currencies, and more. You can use the spreadsheet program to change the format in which the numbers, currencies, or dates are displayed. You can also change a spreadsheet’s appearance by choosing a different alignment for the contents of cells, changing font type and size, and using colored text or backgrounds. 
The real power of a spreadsheet comes from the formulas that perform calculations using the data in the spreadsheet cells. You can specify a formula to sum up the values of a column, for instance. Spreadsheets have hundreds of different formulas, including simple mathematical ones like sum, average, minimum, and maximum. There are also financial formulas that compute interest rates, logical formulas that operate on cells if specified conditions are true, and more sophisticated mathematical functions. All formulas are denoted by name and cell range. 
Popular Spreadsheet Programs
Spreadsheet programs are available within suites of office software, on their own, or both. Starting in the mid-1990s and continuing to the present, Microsoft Excel has dominated the commercial electronic spreadsheet market. Even though Excel is the most popular spreadsheet application, there are other spreadsheet applications that you should know about:
Apple Numbers is Apple’s spreadsheet application. It focuses on usability and effective chart presentation but lacks certain features such as a pivot table.
Calc is the Apache OpenOffice spreadsheet application, modeled after Excel. This is a free, open source program. Calc can both open and save in the Excel (XLS and XLSX) file format. You can download Calc from the OpenOffice website. 
Gnumeric is a free spreadsheet program that is part of the GNOME Free Software Desktop Project. Gnumeric is very similar to Excel and is intended to be a free replacement for proprietary spreadsheet programs like Excel. Gnumeric has the ability to import and export data in several file formats, including CSV, XLS, XLSX, and HTML.
With the advent of advanced web technologies such as Ajax around 2005, a new generation of online spreadsheets has emerged. These web-based online spreadsheets have many of the features seen in desktop spreadsheet applications. Google Sheets on Google Drive is a good example of this. One big advantage of web-based spreadsheets is that they make it easy for multiple users to collaborate. Some web-based spreadsheets offer real-time updates from remote sources, for information such as stock prices and currency exchange rates. You can download a Google Sheets spreadsheet from the cloud to your hard drive in an Excel format or other useful formats if needed. Microsoft Office 365 is the web-based full-featured version of Office 2013. It includes Excel but runs as a web-based application instead of from your hard drive. Web-based applications such as this work well on tablet computers such as the Chromebook in addition to more traditional laptop and desktop machines.
Student Resource 7.4
Research: Pricing Components for 
Your Dream Personal Technology System
Student Names:_______________________________________________ Date:________________
Directions: Remember, you have a budget of $5,000 to spend on your dream system. A spreadsheet is the perfect tool to help you keep track of each part of your system and its cost. As part of your culminating project work, you will be creating a spreadsheet that lists the components of your dream system along with the manufacturer and price of each component. By researching the prices of your components and creating a spreadsheet that keeps a running total of your expenses, you will be able to stay on target.
The first step is to do some research on the Internet to find prices for your components. Since you haven’t defined all the items you need for your dream system yet, you will be pricing only your peripherals in this exercise. Then you can add the other components to your spreadsheet as you go, because you will have the skills you need to do the research and work with the spreadsheet.
Follow the instructions below to research prices for your peripherals on the web.
Online Research Tips
It is easy to look at prices for computer parts by going to online shopping sites. Most consumers buy prebuilt computers from companies such as Dell or Hewlett-Packard. This is becoming even more popular, because these companies offer customization options for the computers they sell. But for your dream system, you need to buy parts to make sure you get exactly what you need. There are websites that offer individual computer components, either for those intending to upgrade their computer or for those who are planning to build their own. By building your own computer, you can buy each specific part that you want. Of course, you need to know what you are doing, because the pile of computer parts won’t do anything useful until you put them together correctly.
Some sites that will probably be helpful for figuring out prices of computer parts and other hardware are Newegg.com (http://www.newegg.com), TigerDirect.com (http://www.tigerdirect.com), and Amazon.com (http://www.amazon.com). Newegg.com and TigerDirect.com are online electronics sites. Since they specialize in tech products, you can probably find everything you need there for your system, but it is still important to look elsewhere to see whether you can find better deals. Amazon.com is a shopping site that sells many different types of products. Its selection includes hardware and peripherals. In addition to these websites, you can look for other online retailers, which may offer better deals. For the project, restrict your research to new commercially available parts, rather than parts available on sites such as eBay. 
Price isn’t the only consideration when choosing components. There’s also performance to consider. Your goal should be to find the best performance you can at the lowest price. For example, you can buy a video card for $69, but that won’t do you any good if it won’t handle the graphics applications you throw at it. You can also buy a video card for $699, but you’re spending way too much if it packs more power than you’ll ever need. A good methodology to follow is to establish a price point you want to meet for each component, determine which components fall at or below that price point, and then review comparative speed tests (called benchmarks) for those components online. An excellent resource for benchmarks is Tom’s Hardware (http://www.tomshardware.com). It has one of the more extensive benchmark databases on the web.
Collecting the Data
To collect the data, follow these steps:
In the first column of the table below, make a list of the peripherals you want to buy for your dream system. 
Using the suggested websites, search for each of the peripherals, and find at least two different options for each. 
In the second column, list the manufacturer. You may also want to include the model number in this column so that you know which device you are looking for.
In the third column, list the best price.
In the fourth column, list the highest price you find for the peripheral. This will remind you how much the part could cost.
When you have filled out all four columns, you have the information you need to create your spreadsheet in the next activity.
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	Best Price
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Student Resource 7.5
Assignment: Designing a Spreadsheet for Your 
Dream Personal Technology System
A good way to learn new Microsoft Excel skills is to create a professional spreadsheet. For this assignment, you will create a spreadsheet that itemizes the parts you intend to purchase for your dream system. Your spreadsheet will display the name of each item, the best manufacturer, the best price you can find, the highest price you found, and the average price for each component. You can also have a column for comments to remind yourself about important information you find in your research, such as the name of the site where you found the best price for each item. 
To create this spreadsheet, follow the tutorial in Student Resource 7.6 step by step. Before you begin work on your spreadsheet, review the assessment criteria, and ask your teacher for more information if you have questions about any of them.
Make sure your spreadsheet meets or exceeds the following assessment criteria:
The spreadsheet details information about at least four peripherals.
All rows and columns are labeled as directed in the tutorial (six columns, at least five rows, and so on).
The spreadsheet uses the averaging function, as evidenced by all rows featuring an average price, located in column E.
The spreadsheet uses the AutoSum function, as evidenced by totals included for each column.
The printout contains only the populated fields of the spreadsheet.
All information on the spreadsheet is accurate.

Student Resource 7.6
Tutorial: Designing a Spreadsheet for Your Dream Personal Technology System
[bookmark: A_simple_spreadsheet_design]Directions: Follow the steps in this tutorial to convert your itemized list of parts for your dream system into a spreadsheet that displays the name of each item, the best manufacturer, the best price you can find, the highest price you found, and the average price for the component. Add a column for comments to remind yourself about important information you find in your research, such as the name of the site where you found the best price for each item.
Open Excel and start working on a blank sheet. Save the document with a name related to your dream system project so that you will be able to find this document and continue to work on it throughout your project.
Create your spreadsheet with six columns labeled “Part,” “Best Manufacturer,” “Lowest Price,” “Highest Price,” “Average Price,” and “Comments.” You’ll enter the details for each part in a separate row under these columns. Your spreadsheet will have column labels in cells A1 to F1 (remember, cells are addressed by their column and row coordinates):

A1: Part
B1: Best Manufacturer
C1: Lowest Price
D1: Highest Price
E1: Average Price
F1: Comments

Your spreadsheet should look something like this: 
[image: excel_shot1]
Use the data you collected in your research on prices for your dream system peripherals. Enter the details for your first peripheral in the second row—that is, cells A2 to F2. Be sure to use the dollar sign with your prices. You can use the Comments column to make a note of the URL where you found the lowest price for each component. Typing the URL in the Comments column will create an actual link (called a hyperlink) to the website, which you can use later to return to the website. Leave the Average Price column blank; the spreadsheet program will calculate that price for you. 
[bookmark: Figure1]Data for the second peripheral will go in cells A3 to F3, data for the third peripheral will go in cells A4 to F4, and so on. When you’re entering data, simply click in a cell to position the cursor, type the value into the cell, and then move to a new cell by using the arrow keys or (in most spreadsheets) by pressing the Tab key.
Your spreadsheet should look something like this:

[image: excel_shot2]
Calculating the Average Price
Now that you have the best price and the highest price for each peripheral, you could calculate the average price manually, but that’s what your spreadsheet is for: doing the manual labor of calculating. So, instead of working out the value and typing it in the appropriate row in column E, insert a formula in column E instead of a value.
Place the cursor in cell E2. This is the cell where you want to see the average price of your first peripheral. 
Click the Formulas tab on the ribbon, and in the Function Library group, click Insert Function to display the Insert Function dialog box. 
In the Select a Function box, select Average and then click OK. The Function Arguments dialog box displays.

[image: ]
In the Number 1 box, you should see “C2:D2.” That means it will give you the average of the numbers in cell C2 through D2. That’s what you want, so click OK. 
Now cell E2 displays the average price, and the data entry box above the spreadsheet displays the formula you used. Notice the “=” sign before the Average function name. This tells the spreadsheet to calculate the result and place the numeric result in the cell. The formula is still there in the cell, but it’s hiding below the calculated value.
Suppose you hunt around a bit and find a lower price for this peripheral. What happens to the number in the Average Price cell if you change the value in the Best Price cell? Try it and see.
It is even easier to calculate the Average Price column for the peripherals in the other rows. Spreadsheet programs are made so that if you type in the first formula and then copy and paste it to new cells, the formula will update based on its new position. 
Using the cursor, select cell E2. Use the shortcut Ctrl+C to copy the formula in that cell.
Next, select all the cells in column E where you want to place average values. 
Use the shortcut Ctrl+V to paste into those cells the average formula that you copied. Now each of the cells in the Average Price column should display the average price for the peripheral in that row. No matter how many different parts you are interested in buying, you can copy and paste the first formula into all the later Average Price cells. The spreadsheet will do the busywork of utilizing the appropriate formula in each cell.
Calculating the Total Price
Finally, to complete your spreadsheet, you need to calculate some totals so that you know how much all of your peripherals will cost you. In addition to giving you the option of inputting formulas instead of just values, spreadsheets have an automatic sum feature that adds ranges of cells for you. In Excel, there is an AutoSum button on the toolbar that looks like this: . Click the cell where you want the total to appear, and then click the AutoSum button. The program will guess which cells you want to add and highlight them. If it guessed correctly, just press Enter and you are done; if not, it is a simple matter of redefining the range you would like added together.
On your spreadsheet, in the row below your last peripheral, create a row entitled “Totals.” Then, in the C, D, and E columns of that row, use the AutoSum button to calculate the total value for each of the columns. 
When all of the values display, select the row of totals and make it bold so that the total values stand out.

[image: ]
Performing a Common-Sense Check
As helpful as all the spreadsheet functions are, it is still easy to get disoriented in the maze of cell references. You need to pay close attention and check your work to ensure that your spreadsheet formulas perform the right actions on the correct range of cells. The best way to do this is called a “common-sense check.” Look at the values in the different cells, and make sure they make sense. For example, the average price should be somewhere between the best price and the highest price. The total price should look somewhere in the ballpark of what you would get if you added all the numbers in the column. Use this kind of reasoning to quickly check all of your values.
Printing a Spreadsheet
Finally, you need to print the spreadsheet so that you can hand it in for assessment. One tricky thing with spreadsheets is telling the printer which part of the spreadsheet you want it to print. You want to print only the area with your data in it, not all the empty cells that you can see. Here is how to define the right area for printing: 
On the View menu, click Page Break Preview. 
Using your mouse pointer, select the area you want to print. 

[image: excel-shot5]
Click the Page Layout tab, then in the Page Setup group, click Print Area, and then select Set Print Area. When you save the document, your print area selection is also saved. You can use the Print Preview option on the Print menu to check if you have what you want prior to printing.
From the Microsoft Office button, select Print. In the Print dialog box, select the correct printer, and print your spreadsheet.
Save this spreadsheet according to your teacher’s instructions. You will need to have access to this spreadsheet so that you can continue to update it for your final project.
Student Resource 7.7
Assignment: 
Using a Database to Create an Email Blast
For as long as humans have had things, they have needed to keep track of them. The Sumerians kept track of things with symbols on clay tablets. Ancient Egyptians used papyrus scrolls. The ancient Chinese used paper made from mulberries, and the Inca used knots in colored strings. Today we store information in the computer database. With such a tool, we can store and retrieve information.
Have you ever used iTunes? If you answered yes, you’ve used a database. The information in computer databases is arranged as a table with columns and rows. In database terms, a column is a field, and rows are records. For example, each song in an iTunes database is a record, and each piece of information (title, artist, or album) is a separate column, or field. When users need information, they ask a question of the database, or query it.
One simple but powerful use of a database is to send out the same email to a group of people but customize the content so that it is personalized for each person that receives it. This is sometimes called an email blast, and professionals with small businesses sometimes use this technology to contact clients or potential clients. The tool used for this is called Mail Merge. Both Microsoft Office and Google have Mail Merge tools.
In this assignment, you are going to use Gmail and a Google Drive spreadsheet to create an email for your culminating project members reminding them of a planning meeting for your culminating project. If you don’t have a meeting coming up, you can make it a fictitious meeting, but you will actually send the emails to your team members and check that the mailing works correctly.
You will use a Google Drive spreadsheet to create a database with a list of your team members, an email address for each team member, and personalized message content for each team member. Then you can write an email using Gmail and use the Mail Merge feature to insert the personalized information into each copy of the email before you send it. 
Student Resource 7.8, Tutorial: Using a Database to Create an Email Blast, provides step-by-step instructions for creating your database and your email. Review the example email in this resource and use it as a sample of the types of information you might want to include in your email. 
Be sure to review the assessment criteria for this assignment before you begin work.

Make sure your letter meets or exceeds the following assessment criteria:
The email template has correctly formatted Mail Merge fields.
The email is professional in tone and subject.
The email features merged email addresses from a spreadsheet list.
The email includes merged data customized to the recipient. 
The email is neat and uses proper spelling and grammar.


Example: Email Merge Letter
In this example, the Mail Merge fields are highlighted in yellow.

3/24/2015
To: Fred Flintstone
Dear Fred, 
This is a reminder that we will meet as a team on April 1, 2015, to work on our PowerPoint presentation for the culminating project in our Principles of Information Technology class. The meeting is at 1:00 p.m. in Room A9 at Bedrock High School. Please be on time. Please place a copy of your slides for the PowerPoint presentation on our Google Drive so that they can be shared among all our teammates. Please do this in advance so I can combine them before the meeting.
Your piece is as follows: CPU and Tower Case/Power Supply, Wireless/Bluetooth Keyboard
In our final presentation, you will speak second.
Thanks in advance for your help!
George Slate
Team Leader


Student Resource 7.8
Tutorial: Using a Database to Create an Email Blast
Directions: The Mail Merge feature in Google Gmail allows you to customize an email blast so that each recipient receives a personalized message. You use Gmail to create a form letter and then insert personalized address information or messages into each copy that you generate. Follow the steps below to create a form email to send to your culminating project teammates. 
Overview of Gmail’s Mail Merge 
You can use Gmail’s Mail Merge feature and a Google Drive spreadsheet to customize mass emails in a fraction of the time it would take to prepare a separate email for each recipient. You create an email that contains information you want to send to many recipients, and then you include space for information that varies (name, address, greeting, and so on) for each recipient. In essence, you prepare a form email with placeholders, and this email gets combined with a Mail Merge database (in this case, a Google Drive spreadsheet) that contains a list of the variable information to produce a group of customized emails. 
Try It Yourself
In this exercise, you will use Gmail and a Google Drive spreadsheet to create a reminder email for your culminating project team members. The email will remind them of a planning meeting for your culminating project. If you don’t have a meeting coming up, you can make it a fictitious meeting, but you will actually send the emails to your team members so that you can check that the mailing works correctly.
Create Your Email
1. Go to Gmail and write an email similar to the example email in Student Resource 7.7, Assignment: Using a Database to Create an Email Blast. Decide what information will change for each customized email and in its place use a field variable: $%fieldname% (where fieldname is the name of a column in your accompanying spreadsheet). The field variable name in the email template must match the field name in the spreadsheet exactly.  
Include a subject on the subject line of the email (with or without field variables). You will need to use this subject when you set up your variables.
Leave the recipient line blank.
Check the spelling, grammar, and formatting. When completed, your email should look similar to the following sample:
[image: ]
Include any graphics or attachments as you normally would, but keep it professional.
Save the email as a draft by pressing Ctrl+S; close it by clicking the X in the upper-right corner. Do not try to send it.
Create Your Spreadsheet
1. Open another tab on your browser and go to Google Drive, and create a new spreadsheet. Type one of your field names at the top of each column, and type email at the top of one column. Fill in the data for each member of your project team. In the email column, type your team members’ Gmail addresses. Check twice to make sure there are no typing errors!
1. Go to the Add-ons menu at the top of the spreadsheet and select “Get add-ons.” Type the words Mail Merge into the search box and press Enter.
1. Scroll down until you find “Yet Another Mail Merge.” Click the Free button and then click Accept. You may get an error message, but the Mail Merge has likely been installed anyway.  To check if it is installed, click the Add-ons menu again; Yet Another Mail Merge should now appear in the menu. 
1. Be sure to save your completed spreadsheet by clicking Share and giving your spreadsheet a title. Your spreadsheet should now look something like the following.
 [image: ]
Running Mail Merge
1. Run the Mail Merge script by clicking Add-ons > Yet Another Mail Merge > Start Mail Merge.
2. On the first pop-up, select the name of the column listing the email addresses from the drop-down menu, and click it so that it appears in the box. Click Save. 
3. On the next pop-up, select the name of your draft email as the template, and click it so that it appears below the box. Also fill in your name as the sender.
4. Click Send Emails to complete your project. Check your Gmail inbox, and in a few minutes or less, have your team members do the same. All of your customized emails should arrive. You will find a copy of each email in your Sent folder. Check them to make sure everything worked properly. Print one sample email to give to your teacher.
5. Yet Another Mail Merge adds a new Merge Status column to your spreadsheet to confirm completion of the task. If you wish to rerun Yet Another Mail Merge after making some corrections, you will need to delete that Merge Status column first.
Congratulations! You have successfully used a database.  
Student Resource 7.9
Project Planner Page 3: 
Planning a Dream Personal Technology System
Student Names:_____________________________________________________________
Directions: This is the third page of the project planner you’ll use to help plan your group’s system. Later, you will add items such as the operating system, Internet access, and other software you need for activities such as creating graphics or listening to music. Remember that you should be keeping track of all of your project planner pages for the entire course. Your group will collect and submit all of these resources at the end of the project. 
Answer the questions below to identify and plan the productivity applications you would purchase, install, or connect to your dream personal technology system. List the factors (such as ease of use, compatibility, features, and so on) that you will keep in mind while outfitting the system. When you are making these choices, remember to think about the specific needs you want your system to address.
When telling about the applications you would choose, be as specific as you can, but don’t worry about the exact version you might buy. For example, if you know you will need a database application but have not yet chosen which, you can come back to this later and add that information as your other plans for the system take shape.
When your group has completed this planner, add the information to the culminating project report you created earlier in this lesson. Be sure to keep that report up-to-date—including adding a line to your project planning summary table!
What this system will be used for:



Software we need to buy: 
(Be as specific as you can, but a general answer like “database” is fine for now.)



Why did you make these choices? 




Additional notes:
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Team planning meeting

To $%firstname% S%lastname%
Dear $%frstnames.

This is a reminder that we will meet as a team on April 1, 2014 to work on our PowerPoint presentation for the culminating project in our Principles of Information Technology class.
The meeting is at 1:00 pm in Room A9 at Bedrock High School. Please be on time. Please place a copy of your slides for the PowerPoint presentation on our Google Drive 50 they
can be shared among all our teammates. Please do this in advance so | can combine them before the meeting.

Your piece is as follows: $%glidenamEs%
In our final presentation, you will speak $%0rder%.
Thanks in advanc for your help!

George Slate
Team Leader

B m +





image9.png
fx

Team project assignments

File Edit

frstname
Fred
Wilma
Bamey
Alice

View

B~

Insett  Format Data Tools Help Mail Merge
$ % 13- Aral - w0 - B 27
B c )
lastname slidenames order
Fiintstone CcPU frst
Hutson Productity Apps  second
Gee Peripherals third
Gomez Networking fourth

Email Address
fred flintstone@gmail. com
WilmaHutson1@gmail. com
Bamey Geel@gmail. com
GomezAlice123@gmail.com




image1.png
Planning a Dream
Personal Technology
System

Frank, Angela, Emily, Devon
5/18/15

Frank, Angela, Emily, Devon

Planning a Dream Personal Technology System
PROJECT PLANNER PAGE 1

WHAT THIS COMPUTER WILL BE USED FOR:

Write your answer here.

WHAT WE NEED TO CONSIDER ABOUT THE FOLLOWING:

« Speed—write your answer here

Reliability—write your answer here

Cost—write your answer here

Ease of Use—write your answer here

Graphics and streaming media capabilities—write your
answer here

HARDWARE WE PLAN TO PURCHASE:

Write your answer here.

WHY WE MADE THESE CHOICES:

Write your answer here.

ADDITIONAL NOTES:

Write your answer here.

Frank, Angela, Emily, Devon

Planning a Dream Personal Technology System

PROJECT PLANNER PAGE 2

WHAT THIS COMPUTER WILL BE USED FOR:

Write your answer here.

PRIMARY PERIPHERALS AND USE:

Write your answer here.

SECONDARY PERIPHERALS AND USE:

Write your answer here.

REASONS FOR THESE CHOICES:

Write your answer here.

ADDITIONAL NOTES:

Write your answer here.

Frank, Angela, Emily, Devon
Planning a Dream Personal Technology System

SUMMARY

Type of Component | Our Choices
Hardware
Peripherals
Software
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